
Thank you for purchasing the Smart 
Loader Package.

This manual contains information for 
ensuring correct use of the product. It 
also provides necessary information 
for installation, maintenance, and 
troubleshooting.

This manual should be read by those 
who design and maintain devices that 
use the product. Be sure to keep this 
manual nearby for handy reference.
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NOTICE

Be sure that the user receives this manual before the product is used.

Copying or duplicating this user’s manual in part or in whole is forbidden. 
The information and specifications in this manual are subject to change 
without notice.

Considerable effort has been made to ensure that this manual is free from 
inaccuracies and omissions. If you should find an error or omission, please 
contact the azbil Group.

In no event is Azbil Corporation liable to anyone for any indirect, special 
or consequential damages as a result of using this product.

© 2015–2019 Azbil Corporation. All Rights Reserved.

The SES™ is trademark of Azbil Corporation in Japan.

IMPORTANT

Do not apply a strong force while connecting a loader plug. Doing so might damage the instrument.

 Handling Precautions
•	Application of excessive force to the loader plug might cause communication failure. If such 

failure happens, reconnect the plug correctly. 
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Unpacking

Check the following items when unpacking:

1. Check the model number to make sure you received the correct product.
2. Check for any obvious damage.
3. Check the contents of the package against the packing list to make sure that all items are included.

Items included in the package are shown below. Handle model SLP-SE7 and its accessories with care to prevent 
damage or loss of parts. If there is any problem with your order, please contact your dealer immediately.

Name Model No. Q’ty Remarks

SLP-SE7 Installation disk SLP-SE7J90 1 CD-ROM

USB loader cable 81441177-001 1

User’s Manual CP-UM-5756E 1 This manual

Packing List CP-UM-5802JE 1 Describes the configuration for 
the SLP-SE7J90 

Software License 
Agreement

CP-UM-5603JE 1 Please read the software license 
agreement carefully before 
installation.
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The Role of This Manual

A total of three different manuals are available for model SES70. Read them as necessary for your specific 
requirements. If a manual you require is not available, contact the azbil Group or its dealer.

User’s Manual for Smart Loader Package Model SLP-SE7 for Intelligent 
Earthquake Sensor Model SES70 � Document No. CP-UM-5756E

This manual.
Included with the system disk for model SLP-SE7. Make sure this is read by the person-
nel in charge of post-setup configuration and operational monitoring. Model SLP-SE7 
is a tool for monitoring and configuring the device from a PC. This manual provides 
detailed instructions on PC installation, loader functions, and operating methods. 

Intelligent Earthquake Sensor Model SES70 User's Manual 
� Document No. CP-SP-1393E

Make sure this manual is read by the person who installs and connects this 
device as well as the personnel in charge of hardware design for using this 
device and maintenance personnel. This manual provides an overview of the 
device and explains the installation method, wiring, startup preparations, and 
troubleshooting.

Intelligent Earthquake Sensor Model SES70 User's Manual for System 
Design 
� Document No. CP-SP-1376E

Make sure this manual is read by personnel who will use this device as well as 
the personnel in charge of hardware design for using this device and mainte-
nance personnel. This manual provides an overview of the device and explains 
the installation method, wiring, startup preparations, internal operations, 
troubleshooting, and hardware specifications. 
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Organization of This User's Manual

This manual is organized as follows:

Chapter 1.	 BEFORE USE
Be sure to read this chapter before you start using the loader.

An explanation of the required PC environment and an overview of functions 
are provided. 

Chapter 2.	 LOADER STARTUP AND SHUTDOWN
Explains Loader environment setup, startup, and shutdown. 

Chapter 3.	 BASIC LOADER OPERATIONS AND FUNCTIONS
Explains the Loader menu structure, basic operations, and an overview of the 
functions available through the Loader.

Chapter 4.	 FUNCTION OPERATIONS
Provides a detailed explanation of Loader functions and operations. 

Chapter 5.	 TROUBLESHOOTING
Explains troubleshooting in the event of an error message or error during error 
status monitoring. 

APPENDIX
Explanation of Terminology 
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Conventions Used in This Manual

¢¢ In describing the product, this manual uses the icons and conventions listed below.

 Handling Precautions:
Handling precautions indicate items that the user should pay attention to 
when handling this module.

 Note: Notes indicate information that might benefit the user.

(1), (2), (3): Numbers within parentheses indicate steps in a sequence or parts of an 
explanation.

This indicates the item or page that the user is requested to refer to.

(Noise protect): Indicates screen message. 

[Display]: Indicates PC screen menu. 

[OK] button, [Graph] tab: Indicates PC screen button or tab. .

[F2] Setup: Indicates a keyboard function key. 

[Enter] key, [Esc] key: Indicates a keyboard key. 

[Settings]>[Control Panel]: Indicates to select [Settings] on the PC screen, and then select [Control Panel]. 

>>: Indicates operation results content displayed on the PC or device, or the 
device status after an operation. 
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�� Overview
The SLP-SE7 Smart  Loader Package for the Intelligent Earthquake Sensor (re-
ferred to as “Loader” below) is a monitoring and configuring tool that runs on a 
Windows PC and connects to our earthquake sensors.

This Loader can connect to the SES70A and the SES60A.

To ensure easy use for beginners, this system assigns each function to a function 
key that allows you to select from menu options.

�� Main functions
This Loader has the following functions.

•	Current value monitoring function for SI value, acceleration speed, etc.

•	Configure sensitivity output and other settings

•	Acceleration waveform collection and monitoring function

•	File save function for settings values and waveform

•	DO, AO manual output function

•	Diagnosis adjustment function

•	Offline file content display function

Chapter 1.	 BEFORE USE
1 - 1 	 Overview
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The following system environment is required to use this Loader.

�� Hardware

Item Description

PC Computer PC/AT compatible machine running a Core2Duo or higher CPU 1 GHz or higher 
32 bit (x86) or 64 bit (x64) processor

Memory At least 1 GB memory or at least 2GB (for 64 bit systems)

Recommended: 2 GB or higher

Operating system English language version of Windows 7 Pro (32 bit)/(64 bit), 
Windows 8 Pro/Ent (64 bit), 
Windows 8.1 Pro/Ent (64 bit) 
Windows 10 
(referred to as “Windows” hereafter)

Peripheral 
Devices

Display 1024×600 resolution or higher, 16 bit color or higher recommended

USB port 1 or more USB port

Hard disk drive or SSD Disk space: At least 100 MB for this software

CD-ROM drive At least one internal drive or an external drive

Pointing device Mouse or equivalent device compatible with Windows

 Handling Precautions
•	FlexGlid70J is installed when you install this Loader. We cannot guarantee 

proper functionality if a different version of FlexGlid is already installed. In 
this case, we recommend using a different computer.

•	 If this loader was installed on Windows 10 by a user with an account type 
other than “administrator,” the loader icon will not be displayed by clicking 
Start → [SLP].  
In this case, start the loader from the SLP-SE7 (SES70) icon on the desktop.

•	Close all other applications prior to launching the Loader. The Loader may 
not function properly if other applications are running.

•	 If Windows Power Management is running, a communications timeout may 
occur if connected for a long time. In such cases, set Power Management to 
OFF (Control Panel > Power Management Settings).

•	Check [Control Panel]>[Regional Options]>[Numbers]>[Decimal symbol] to 
ensure that this is set to “ . ” (a period). SLP-SE7 will not function properly if 
this is set to any other character.

Example

For Windows 7, select [Control Panel]>[Clock, Language, and 
Region]>[Regional and Language]>[Formats] tab>[Additional Settings]> 
[Decimal symbol].

For Windows 8 and 8.1, select [Control Panel]>[Clock, Language, and 
Region]>[Region]>[Formats] tab>[Additional Settings]>[Decimal symbol].

1 - 2 	 Required Operating Environment
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�� Hardware configuration

Loader

Personal Computer

Send/receive 
SES70

Read/save
Data disk 

Dedicated cable (included) 
or RS-485 communication

�� Connection with the earthquake sensor

zz Connection via loader communication (dedicated USB loader cable)
•	This method is for connecting to the PC using the attached dedicated cable 

(Part No. 81441177-001). Under normal conditions, use this method for the 
connection.

•	Connect the dedicated cable to the earthquake sensor loader jack and the PC 
USB port.

USB port

Personal Computer

SES70

USB loader cable
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zz Connection via RS-485 communication
•	This method is for connecting to the PC using a commercial RS-485↔USB 

converter.

•	Use this method for the connection when there is distance between the earth-
quake sensor and the PC.

SES70

RS-485 
communication line 

USB port 

Personal Computer

RS-485 <=> USB
converter 
(commercially available)

•	RS-485↔USB converters for which compatibility has been confirmed are 
indicated below. (We have not confirmed operational compatibility for any 
other devices.)

•	Manufacturer: 	HuMANDATA LTD.

•	Model No: 	 USB-003

•	URL: 	 http://www.fa.hdl.co.jp/en/

•	Manufacturer: 	MOXA

•	Model No: 	 UPort1130I

•	URL: 	 http://www.moxa.com/
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The following explains how to install the Loader onto your PC.

 Handling Precautions
•	The installation program may not function properly if other applications 

are running. Close all other applications before launching the installation 
program.  Furthermore, the Loader may not function depending on the 
combination of other applications, drivers, etc., installed on your PC.  See 
the user manual included with your Windows PC for details on Windows 
and PC settings.

�� Installing the Loader
(1)	 Place the CD-ROM into the CD-ROM drive of your PC.

>> �The installation program will launch automatically and display the fol-
lowing screen.

		

(2)	 Click [Yes] to display the following window.

		

(3)	 Click [Install SLP].
>> �The installation program will launch automatically and display the fol-

lowing screen.

		

1 - 3 	 Installation
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(4)	 Click the [Next (N)>] button.
>> The following software license agreement screen is displayed.

		

(5)	 Click the [Agree] button.
>> The following installation folder confirmation screen is displayed.

		

 Note
•	 (You cannot change the installation destination folder.)

(6)	 Click the [Next (N)>] button.
>> The following screen is displayed.
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(7)	 Click the [Next (N)>] button.
>> The following screen is displayed.

		

(8)	 Select either of the options and click the [OK] button. 
For Windows 10, select [All users].
>> The following screen is displayed.

		

(9)	 Click the [Finish] button.
>> This completes the Installation.

 Note
•	 If Adobe Reader is not installed on your PC, download the software from 

the Adobe Systems website.
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�� Connecting using the USB loader cable

zz How to install the device driver

A device driver must be installed before using the USB loader cable. Follow the 
procedure below to install the device driver.

 Handling Precautions
•	Make sure you follow the procedure detailed below to install the device 

driver.  The USB cable may not be recognized if the procedure is not fol-
lowed. If the driver is not recognized, uninstall the device driver and then 
redo the installation procedure.

•	Administrator privileges are required to install the device driver. This proce-
dure should be conducted by an Administrator or by a user assigned to an 
Administrators Group.

•	 If the PC has multiple USB ports, make sure to insert the USB loader cable 
into the same port each time.  Inserting the cable into a different port may 
require that you reinstall the device driver.

1. Place the SLP CD-ROM into the CD-ROM drive of your PC.

>>	 The installation program will launch automatically and display the follow-
ing screen.

	

(1)	 Click [Install USB loader cable driver]. At this point, do not connect the 
USB loader cable to the PC.
>> The following screen is displayed.

		
(2)	 Click [Next].

>> The following screen is displayed.
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(3)	 Select [Agree] and click [Next].

(4)	 Click [Install this driver software].
>> �The device driver installation is launched. Once completed, the follow-

ing screen is displayed.

		   

(5)	 Click [Finish] to complete the installation.
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2. Connect the USB loader cable to the USB port.

(1)	 Once Windows recognizes the USB loader cable, the following type of 
indicator is displayed in the task tray and the driver installation wizard is 
displayed.

	

(2)	 The following type of indicator is displayed in the task tray once installa-
tion is complete.

	

(3)	 Launch the SLP-SE7. Since communications have not yet been established, 
the system first launches in offline mode. (For details on how to launch in 
offline mode,  Loader startup (offline startup) (P. 2-2).)

(4)	 Open the [File]>[Communications Settings] screen and select the 
[Connect via USB loader cable] radio button.

	

(5)	 Next, click the [Loader cable auto-selection] button. The number of 
the COM port to which the USB loader cable is connected is selected 
automatically.

(6)	 Click the [OK] button to complete the change.

>> The following screen is displayed.
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 Note
•	Clicking the [Auto-select USB loader cable] will cause the port to be se-

lected automatically but, depending on conditions, in some cases the port 
is not selected automatically. In such cases, click the [Device Manager] 
button to confirm that the port number for Yamatake USB Loader 
Comm. is displayed under [Ports (COM and LPT)] then select that port.

 

(7)	 Click the [OK] button. The screen will close.

(8)	 Exit the SLP-SE7 and restart the loader. 
This will enable the communication settings and establish 
communications. 
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�� Connecting via RS-485 Communication
This method is for connecting to the PC using a commercial RS-485↔USB 
converter*.

* �Refer to “1-2 Required Operating Environment“ for details on RS-485↔USB converters 
for which compatibility has been confirmed.

(1)	 Install the driver for the RS-485↔USB converter.  Refer to the user manual 
included with the converter for installation instructions.

(2)	 Connect the RS-485↔USB converter to the earthquake sensor and the 
PC. Since communications have not yet been established, the SLP-SE7 first 
launches in offline mode.

(3)	 Select [File]→[Communications Settings] and select the [RS-485 connec-
tion] radio button.

	

(4)	 Click [Device manager]  and check the COM port number of the RS-
485↔USB converter. Select that port number and station address on the 
[Communication Settings] screen, and click the [OK] button.  
The changes will be saved.

>> The following screen is displayed.

		

(5)	 Click the [OK] button. The screen will close.

(6)	 Exit the SLP-SE7 and restart the loader. 
This will enable the communication settings and establish 
communications. 
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�� How to uninstall SLP-SE7

 Handling Precautions
•	Make sure to reboot your PC after completing the uninstall.  Make sure to 

close all other programs prior to conducting the uninstall procedure.

•	Administrator privileges are required to uninstall the device driver. This 
procedure should be conducted by an Administrator or by a user assigned 
to an Administrators Group.

(1)	 Select [Control Panel]>[Programs and Functions]. Select SLP-SE7 (SES70) 
from the program list and select [Uninstall or Change]. The following win-
dow is displayed.

>> The following screen is displayed.

		

(2)	 Select [Automatic] and click [Next].

>> The following screen is displayed.

		

(3)	 Select [Uninstall]. The uninstallation will be completed after a few 
moments.

 Handling Precautions
•	Uninstalling deletes the content of the SLPSE7 folder on the C: drive but 

the actual SLPSE7 folder is not deleted.  Manually delete the folder if 
necessary.

•	A [FlexGrid70J] folder is created on the C: drive during SLP-SE7 installa-
tion but this folder is not deleted during the uninstallation of SLP-SE7.  
Manually delete the folder if it is no longer necessary.

•	Uninstalling SLP-SE7 does not delete any SLP-SE7 data saved in the user's 
My Documents folder.  Manually delete this data if it is no longer necessary.

1 - 4 	 How to Uninstall
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�� How to uninstall the USB loader cable driver

 Handling Precautions
•	Make sure to reboot your PC after completing the uninstall. Make sure to 

close all other programs prior to conducting the uninstall procedure.

•	Administrator privileges are required to uninstall the device driver. This 
procedure should be conducted by an Administrator or by a user assigned 
to an Administrators Group.

(1)	 For Windows 7 (32 bit), select [Control Panel]>[Programs and Functions 
- Windows Driver Package Yamatake (YCspl) USB (04/10/2008 2.2.8)] and 
click the [Uninstall or Change] button.

For Windows 7 (64 bit), Windows 8 (64 bit), or Windows 8.1 (64 bit), 
select [Control Panel]>[Programs and Functions - Windows Driver 
Package Prolific (Ser2pl64) Ports (11/19/20092.0.13.130)] and click the 
[Uninstall or Delete] button.

	

(2)	 Click the [Yes] button.

(3)	 Reboot your PC.

�� How to uninstall the RS-485↔USB converter driver
•	Refer to the user manual included with the converter for uninstallation 

instructions.
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Close all other applications prior to launching the Loader. The Loader may not function properly if other ap-
plications are running.

�� Environment setup
Check [Control Panel]>[Regional Options]>[Numbers]>[Decimal symbol] to 
ensure that this is set to “ . ” (a period). (Normally, this is already set to period.)

For details,  1-2 Required Operating Environment (P. 1-2).

�� Connecting the earthquake sensor to the PC
Connect the earthquake sensor and PC via the dedicated USB loader cable. You 
also can use a commercially available RS-485↔USB converter and connect via 
RS-485 communication.

You do not need to connect the earthquake sensor with the PC if you only want 
to view files (offline). To startup the device in offline mode, remove the commu-
nications cable from the PC.

Removing the cable while online or any other communication failure will re-
sult in the following message: “A connection timeout error occurred with the 
earthquake sensor. Exiting program.” The system will then return to Windows. 
Reestablish the connection and restart the loader.

The Loader will detect the device type (SES70, SES60) automatically when the 
device is connected to the PC. The Loader display and available operations will 
reflect the detected device.

Chapter 2.	 LOADER STARTUP AND SHUTDOWN
2 - 1 	 Loader Startup
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�� Loader startup (online startup)
With the earthquake sensor connected to the PC, double-click the 
SLPSE7 (SES70) icon on the PC desktop.

Or, click the [Start] button at the bottom of the screen and then select 
[Programs]>[SLP]>[SLP-SE7 (SES70)]. Make sure to complete communications 
setup before you launch the Loader. 
(To start the loader on Window 10, double-click the SLP-SE7 (SES70) icon on 
the desktop.)

For details,  1-3 Installation “Connecting using the USB loader cable” or 
“Connecting via RS-485 Communication.”

>>	 The Loader will startup and the following main menu is displayed. After 
normal system startup, “Online” should be indicated in the status view.

�� Loader startup (offline startup)
(1)	 With the earthquake sensor not connected to the PC, double-click the 

SLP-SE7 (SES70) icon on the PC desktop. 
Or, click the [Start] button at the bottom of the screen and then select 
[Programs]>[SLP]>[SLP-SE7 (SES70)]. 
(To start the loader on Window 10, double-click the SLP-SE7 (SES70) icon 
on the desktop.)

>> The following screen is displayed.
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(2)	 Click the [OK] button to close the error screen.  
>> The following [File Open] window is displayed.

		

(3)	 Select the settings file “sample_001_S00.SE7” and click the [OK] button.  
>> After offline startup, “Offline” should be indicated in the status view.
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To exit the Loader, return to the main menu and select [File]>[Exit]. Or, press [F8] Exit.

Click [Yes] when the following screen is displayed. The system will then return to Windows.

In an mode other than Measurement mode, the following warning screen is displayed when you attempt to exit 
the Loader. If the earthquake sensor is not in Measurement mode, then the basic earthquake sensor functions 
(SI value calculation, analog output, control output, waveform recording, etc.) are not available. Make sure to 
confirm the earthquake sensor mode before exiting the Loader.

2 - 2 	 Loader shutdown
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This chapter explains the Loader menu structure, basic operations, and an overview of the functions available 
through the Loader.

For a detailed explanation of each function,  Chapter 4. FUNCTION OPERATIONS.

Chapter 3.	 BASIC LOADER OPERATIONS AND 
FUNCTIONS
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�� Displaying and transitioning between screens
The screen is divided into the following areas. The content of display area A will 
vary depending on the operating mode.

Other than display area A, these regions are common to all modes.

Display region A: �Main screen
Display region B: �File name display
Display region C: �Online/Offline status, function name
Display region D: �Information indicating operating mode (when online)
Display region E: �Maintenance mode phase indicator
Display region F: �Waveform recording indicator
Display region G: �RS-485 communications write status
Display region H: �Upper line: PC time

Lower line: Earthquake sensor internal time (only when online)
Display region I: �Supplemental menu display
Display region J: �Display menu tree
Display region K: �Error indicator
Display region L: �Main menu display (menu allocated to function key)
Display region M:�Connected earthquake sensor information display
Display region N: �Connected communications port information display

B C D E F G H

M N

A

I

J

K
L

Use function keys [F1], [F2], [F3], [F5], [F6], [F7], [F8] to transition between 
screens.

The [F4] key is not used.

Use the [F8] key to return to the previous screen.

In addition to function keys, you can use the menu tree displayed in display area 
J to transition between screens.

3 - 1 	 Basic Operations
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�� Menu structure
There are two types of Loader menus: the main menu displayed in display area L 
of the window and the supplemental menu displayed in display area I (Windows 
standard menu area).

zz Main menu structure
The main menu structure is as follows.

The main menu is designed so that the user transitions between each mode 
(functions) by using the function key or by selecting from the hierarchal menu 
in the displayed menu tree.

For example, when Top is displayed for Monitor, pressing the [F1] key will cause 
the screen to transition to that item.

You also may use the mouse to click on the menu display area for the function 
keys at the bottom of the screen.

This is also displayed if you click on the area displayed as Monitor in the menu 
tree displayed at the left of the screen.

Top [F1] Monitor [F1] Alarm Detail
[F2] Trend [F1] SI Value (PV)

[F2] Synth. Accel. (PV)
[F3] [Calc. Accel.]
[F4] Calc. AC Accel.
[F3] [Incli. Accel.]
[F6] Display
[F8] Return

[F8] Return

[F2] Setup [F1] [Reset setting values]*
[F2] [Accel. Filter]*
[F3] [Output Selection]*
[F3] Save file
[F5] Open file
[F6] Set sensor date/time
[F7] Write settings
[F8] Return

[F3] Waveform [F1] Rec. Cond.
[F2] Display waveform
[F3] Display
[F4] [SV Record Display]
[F5] Save file
[F6] Force record
[F7] Delete waveform
[F8] Return

[F7] Write settings
[F8] Return

[F1] Select SV record targets
[F8] Return

[F5] Manual [F8] Return

[F6] Diagnosis [F3] Start diagnosis
[F4] Zero adjustment
[F7] [Write settings]
[F8] Return

[F7] Mode Change*

[F8] Exit

� Functions indicated in [  ] are functions that can be selected during multiple function settings display.

 Handling Precautions
•	 Conducting operations marked with “ * ” in any mode other than 

Measurement mode will result in the transition to Initialize mode. Please 
note that the SES60 may produce unstable analog output in Initialize mode.



3-4

Chapter 3.  BASIC LOADER OPERATIONS AND FUNCTIONS

zz Supplementary menu structure

The supplementary menu structure is as follows.

The supplementary menu is operated using the mouse.

Use the displayed pull-down menu to switch between settings levels.

There is a Basic Setup display and a Full Setup display. The displayed menu 
items will vary depending on the display.

Supplementary menu File Save screen display in HTML

Communication settings

Exit

Display Basic Setup

Full Setup

Help SLP-SE7 Smart Loader Package User Manual PDF

SES70 Intelligent Earthquake Sensor User Manual 
(For Design) PDF

Version

�� Online and Offline
The operations displayed in each window of this Loader will vary depending 
whether the PC is connected to the earthquake sensor via a dedicated cable (on-
line) or not connected to the earthquake sensor (offline). Some operations are 
only available when the system is online.

When online, the current mode of the earthquake sensor is displayed in dis-
play area D. The earthquake sensor has four modes: Initialize, Maintenance, 
Measurement, and Standby.

When offline, you can confirm previously saved files containing settings values 
and waveform data.

 Handling Precautions
•	The operation mode is displayed only when the system is online.
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zz About online standby mode

Changing settings, deleting waveform records, etc., requires that the system be 
in Standby mode.

However, settings data monitoring can be conducted in any mode.

When you operate the Loader and a screen transition is required, a confirmation 
message is shown asking if you want to transition to Standby mode. Follow the 
instructions indicated in the message.

The following functions are available in Standby mode.

Menu Operation

Monitor •	Confirm current values

Setup •	Setup
•	Save settings file

Waveform •	Save and delete record data
•	Change waveform recording conditions

Save file •	Save file

Manual •	Manual output

Diagnosis •	Pickup diagnosis
•	Acceleration zero adjustment

 Handling Precautions
•	The automatic waveform recording function is not available in Initialize 

mode, Maintenance mode, or Standby mode.

�� Function
This Loader provides the following 6 types of functions.

•	Monitor

•	Setup

•	Waveform

•	Manual

•	Diagnosis

•	Mode change

An overview for each function is explained in the following pages.
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The Monitor displays the status of the current earthquake sensor operation.

In the main menu, press [F1] Monitor. Or, select [Top]>[Monitor] from the displayed menu tree.

Error information is continuously monitored. In the event of an error, the information is displayed in display 
area K* regardless of which screen is being displayed.

*	  3-1 Basic Operations (P. 3-2) for information on the display area. 
 Chapter 5 Troubleshooting for a list of error messages.

�� Monitoring Screen
This screen displays the earthquake sensor operating mode and measurement 
results, calculation results, and output status.

3 - 2 	 Monitor
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�� Trend display
SI value (PV value), synthetic acceleration (PV value), calculation acceleration*, 
calculation AC acceleration, and calculation inclination acceleration* can be dis-
played as a trend graph. (* is only for Full Setup Display)

Click [F2] Trend. Each trend is displayed after clicking the button. Here, sam-
pling takes approximately 1 second. This creates a buffer containing approxi-
mately 500 seconds of data, allowing you to view past trends. Sampling stops 
once the buffer becomes full. Return to the main menu and click [F2] Trend 
under [F2] Monitor to clear the buffer and start sampling.
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�� Error Details Window
Display error details by clicking [F1] Alarm Detail.

You also can select [Top]>[Alarm]>[Present] in the displayed menu tree to dis-
play error details.

Click [F1] Alarm Detail in the previous screen to switch between the error infor-
mation display and the current error information display for the error informa-
tion latched on the earthquake sensor.

You also can select [Top]>[Alarm]>[Latch] in the displayed menu tree to display 
the error information latched on the earthquake sensor.
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Allows you to configure earthquake sensor control output settings, time, AO scaling, device address, etc. Press 
[F2] Setup in the main menu. You also can select [Top Setup]>[Setup] in the displayed menu tree.

Press [F4] File Save to save the settings.

Press [F5] File Open to display saved settings on the PC Loader.

 Handling Precautions
•	The automatic waveform recording function is paused if Standby mode is 

selected when switching to the Setup window.

•	 [F4] File Save is not available when the system is offline.

•	To prevent unintended operations, [F5] File Open cannot write the settings 
data saved in the file to the earthquake sensor. This only displays the con-
tents of the saved file.

The settings content window is shown below.

�� Setup window

3 - 3 	 Setup
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Displays the 10 waveforms recorded in the earthquake sensor and one forced waveform.

You also can save displayed waveforms onto the PC.

Press [F3] Record Waveform in the main menu. You also can select [Top]>[Waveform]>[Waveform List] in the dis-
played menu tree.

The waveform can be displayed as a graph or as a numeric representation.

 Handling Precautions
•	The automatic waveform recording function is paused if Standby mode 

is selected when switching to the Setup window or the Record Waveform 
window.

•	Change Recording Conditions, Force Record, Delete Waveform are avail-
able only in standby mode.

�� List of Recorded Waveforms window
Align the cursor with the number of the waveform graph you want to display 
and press [Enter] to go to the waveform graph display window.

You also can got to the waveform graph display window by using the left mouse 
button to double-click on the row of the waveform number for the waveform 
graph you want to display.

3 - 4 	 Record Waveform
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�� Waveform graph display window

Click the [Numeric Value] tab to go to the wave form numeric value window.

�� Waveform numeric value display window

Click the [Graph] tab to go to the wave form graph display window.
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Select Save File from the Setup window in the main menu to save only the settings.

To save the settings and the waveform, select Save File from the Record Waveform window in the main menu.

As when online, after writing to a settings file while offline, the waveform file is displayed via the Record 
Waveform window. (However, only when both the settings file and waveform file have been saved.)

3 - 5 	 File Operations
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You can manually force output when you want to check the earthquake sensor AO, control output, liquefaction 
output, or failure output.

Press [F5] Manual in the main menu.

�� Manual output screen

3 - 6 	 Manual Output
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You can run a diagnosis on the acceleration sensor (pickup).

Adjustment data is configured by default but the inclination adjustment (zero adjustment) can be done at the 
Full Setup window.

Press [F6] Diagnosis in the main menu.

�� Diagnosis window

3 - 7 	 Adjust Diagnosis
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Change the earthquake sensor mode.

Press [F7] Mode Change in the main menu.

A dialog box is displayed.

Change to the desired mode.

�� Change mode window

 Handling Precautions
•	When you select a function, a mode change confirmation is displayed 

during the window transition even if you do not use the Change Mode 
function. Follow the instructions indicated in the message. The mode is 
changed automatically.

•	Note that analog output may be unstable in initialize mode if the SES60 is 
connected.

•	Analog output is always stable with the SES70.

3 - 8 	 Change Mode
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Clicking [F1] Monitor in the main menu will transition the system to the Monitor screen.

Select [Monitor]>[Monitor] from the displayed menu tree.

This monitors the current status of the earthquake sensor.

�� Displaying the Monitor

Basic Setup

Full Setup

Chapter 4.	 FUNCTION OPERATIONS
4 - 1 	 Monitor [F1]
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 Handling Precautions
•	The displayed content (items) will vary between Basic Setup and Full Setup.

•	For SI value and other displayed figures, earthquake gauge internal figures 
are rounded off to the nearest one-tenth.

•	DO1 Output, DO2 Output, and DO3 Output indicate the internal analysis 
results. If negative logic is selected, the status may differ from the actual 
DO terminal. The following indicates the correlation between the display 
and the actual terminal status.

Item Loader display
SES70 terminal status

Positive logic Negative logic

Minor failure (DO1) OFF OFF ON

ON ON OFF

Blinking Slow OK/OFF

Fast OK/OFF

Flashing

One of the above

Slow OK/OFF

Fast OK/OFF

Flashing

One of the above

Serious failure 
(DO2)

OFF OFF ON

ON ON OFF

Noise protect 
(DO3)

OFF OFF ON

ON ON OFF
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�� Confirming error status
To display the content of an error, press [F1] Alarm Detail. You also can select 
[Top]>[Alarm]>[Present] in the displayed menu tree to display error details.

View this information to respond to any errors that occur.

Press [F8] Return to return to the Monitoring screen.

 Note
•	  Chapter 5. TROUBLESHOOTING (P. 5-1) for information on how 

to address.

Press [F1] Alarm Detail again to view the error information latched on the earth-
quake sensor. Press [F1] Alarm Detail to switch between the status display and 
the latch display.

You also can select [Top]>[Alarm]>[Latch] in the displayed menu tree to display 
the error information latched on the earthquake sensor.
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�� Displaying simple trends
To display the simple trends for each value, click [F2] Simple Trend in the 
Monitoring screen. The Calc.AC Accel. Graph for calculation screen is dis-
played. This trend is displayed as a sampling in approximately 1 s intervals. 
(Note that this differs from the sampling cycle of the earthquake sensor.)

The display targets are assigned to function keys as indicated below. Press the 
applicable function key for the trend you want to display. You also can select a 
trend from Simple Trend Display under the display menu.

[F1] SI Value (PV)

[F2] Synth. Accel. (PV)

[F3] Calc. Accel.*

[F4] Calc. AC Accel.

[F5] Incli. Accel.*

� * only when in Full Setup Display

zz Making trends easier to view

You can change the display screen (Trends) if the graph display scale is off or if 
the X, Y, Z axes overlap making the display difficult to view.
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zz Changing the time interval and amplitude

Use one of the following to change the time axis and amplitude.

•	Use the mouse to specify the trend display range.

	
Expand the window by dragging the mouse from the upper left to the 
lower right.

	
Drag from the lower right to the upper left to return the window to the 
default size. The drag position is recognized anywhere, regardless of trend 
width.

•	Click the [▲]/[▼] buttons in the window.

•	Directly input a numeric value in the window input column.
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•	Click the column of the window you want to change and then press the 
[ ↑ ]/[ ↓ ] keys.

	

Entry column
▲: Increase value
▼: Decrease value

After making the change, click the [Redraw] button. To change display content 
to other items, press the [F1] through [F5] keys.

zz Changing the graph display

You can change the number of axis lines displayed if the graph displays of the X, 
Y, Z  axes for the calculation AC acceleration, etc., overlap making the display 
difficult to view.

While displaying a graph, press [F6] Display or right-click on the graph to dis-
play a list of display change options.

[2D/3D Display Dimension]: Switch between a flat graph and 3D display.

[Manual/Auto Scale ]: �Switch between auto and manual adjustment of the graph 
width range. After switching to manual, when you switch 
back to auto the settings revert to the settings applied 
prior to switching to manual.

[X color]: Changes the color of the X-axis

[Y color]: Changes the color of the Y-axis

[Z color]: Changes the color of the Z-axis

[X Hide/Show]: Switch between displaying and hiding the X-axis.

[Y Hide/Show]: Switch between displaying and hiding the Y-axis.

[Z Hide/Show]: Switch between displaying and hiding the Z-axis.
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Pressing [F2] Setup in the main menu will switch to the Setup screen.

You also can select [Top]>[Setup] in the displayed menu tree.

When switching to the Setup screen, a message will be displayed asking if you want to switch to Standby mode.

•	To change settings, click [Yes] and switch to Standby mode.
•	To confirm current settings, click [No] to change screens without switching to 

Standby mode.
•	To cancel, click [Cancel]. The system will return to the Top screen.
After changing the settings, press [F7] Write Settings.
Basic Setup

Full Setup

 Handling Precautions
•	The displayed content (items) will vary between Basic Setup and Full Setup.

4 - 2 	 Setup [F2]
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�� Setting item
The following settings can be changed on the SES70.

zz SI Values [SES70 only]

Select either SI Value 1 or SI Value 2.

SI value 1: 7 fixed cycles, 8-direction projection

SI value 2: 24 fixed cycles, 16-direction projection

SI Values - Default value: SI Value 1

zz Synthetic acceleration types

For the synthetic AC acceleration PV Value, select between calculation synthetic 
AC acceleration and control synthetic AC acceleration.

Synthetic acceleration types - Default value: Control synthetic AC 
acceleration

zz Select the number of synthetic acceleration axis lines

For the synthetic axis of both calculation synthetic AC acceleration and control 
synthetic AC acceleration, select flat 2-axis (X/Y) or 3-axis.

Calculation - Default value: 2-axis; Control - Default value: 3-axis

zz Select M.V.E.V. formula (Full Setup only)

For the M.V.E.V. formula (formula for the Japan Meteorological Agency seismic 
intensity scale value), select either the formula that calculates using both SI 
Value and acceleration or the formula that calculates using only SI Value.

Formula 1: uses both SI Value and acceleration

Formula 2: uses SI Value only

M.V.E.V. default formula: formula 1
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zz J.V.D. settings

You can set three J.V.D. conditions. (J.V.D.1 Condition, J.V.D.2 Condition,  
J.V.D.3 Condition) [For SES60, only J.V.D.1 Condition is available]

For each J.V.D. Condition, you can select the SI value for turning the Control 
Output ON/OFF, the synthetic AC acceleration, the M.V.E.V. value, and the logic 
calculation for liquefaction judgment value.

You can set the threshold values for the SI value used for control output, the syn-
thetic AC acceleration, and the M.V.E.V.

Item name Setting Default value Set 
increments

J.V.D.1 OR condition

J.V.D.1 AND condition

The logical sum of the AND condition and OR condition 
are set as the J.V.D. condition. However, both AND/OR 
conditions cannot be set for the same field.

AND condition: The AND condition of the setting field 
is set as the J.V.D. condition. OR condition: The OR 
condition of the setting field is set as the J.V.D. condition.

AND condition: None

OR condition: None

—

J.V.D.1 SI Threshold 1 to 300 kine 300 1 kine

J.V.D.1 Synthetic 
acceleration threshold

5 to 4000 Gal 4000 1 Gal

J.V.D.1 M.V.E.V. threshold 1.0 to 7.9 7.9 0.1

*The same also applies for J.V.D.2 and J.V.D.3.

Click the line of the [J.V.D. Cond. OR] or [J.V.D. Cond. AND] to set the J.V.D. con-
dition. The following window is displayed regardless of which one you click. Set 
the OR condition and the AND condition. The enabled settings are those with a 
highlighted button.

However, both AND/OR conditions cannot be set for the same field.

 Handling Precautions
•	The default values for J.V.D. have changed compared to the SES60. Refer 

to the following table to see the points of difference. The default setting 
for the SES70 is to not conduct J.V.D. so make sure to configure this setting 
prior to use.

Default settings for J.V.D. condition (comparison with previous model)

Item SES70 SES50/51/55/60 
(Previous model)

J.V.D. OR condition
J.V.D. AND condition

OR condition: None
AND condition: None

OR condition: SI value
AND condition: None

J.V.D. SI Threshold 300 kine 30 kine

J.V.D. Synthetic acceleration threshold 4000 Gal 300 Gal

J.V.D. M.V.E.V. threshold 7.9 5.3



4-10

Chapter 4.  FUNCTION OPERATIONS

zz Output hold time setting

You can set the control output (relay), liquefaction output (DO4), AO1, and 
AO2 hold times. (Control output hold time and liquefaction hold time are avail-
able only in Full Setup mode)

Item name Setting Default value Set increments

Control Output Hold Time 20 to 604800 s 20 s 1 s
DO4 Output Hold Time 20 to 604800 s 20 s 1 s
AO Output Hold Time 20 to 604800 s 20 s 1 s

zz Select AO span

You can change the span allocation setting of 0 to 100 % (4 to 20 mA) for AO1 
and AO2.

Item name Setting Default value Set increments

SI AO span Select from 50, 100, 150, and 200 kine/20 mA 200 kine 1 kine
Synth. accel. AO span Select from 500, 1000, 2000, and 3000 Gal/20 mA 2000 Gal 10 Gal
M.V.E.V. AO span Select either 5.0 or 8.0 (20 mA) 8.0 0.1

Instead of selecting, you can double-click the item and directly input a span value.

zz Select AO object

You can select the output object data for AO1 and AO2.

Item name Setting Default value Set increments

Select AO1 object Select from Synth. Accel. (PV), SI (PV), or M.V.E.V. (PV) Synth. Accel. (PV) —
Select AO 2 object Select from Synth. Accel. (PV), SI (PV), or M.V.E.V. (PV) SI value (PV) —

zz AO ratio setting (Full Setup only)

You can select the output ratio for AO1 and AO2.

Item name Setting Default value Set increments

AO1 ratio 0.900 to 1.100 1.000 0.001
AO2 ratio 0.900 to 1.100 1.000 0.001

zz AO bias setting (Full Setup only)

You can select the bias setting for AO1 and AO2.

Item name Setting Default value Set increments

AO1 bias setting −5.0 to +5.0% 0.0% 0.1%
AO2 bias setting −5.0 to +5.0% 0.0% 0.1%

zz PV low cut

You can set a low cut setting for the SI PV, Synth. Accel. PV, and M.V.E.V. PV.

Item name Setting Default value Set increments

SI PV low cut 0.0 to 30.0 kine 1.0 kine 0.1 kine
Synth. Accel. PV low cut 0.0 to 400.0 Gal 5.0 Gal 0.1 Gal
M.V.E.V. PV low cut 0.0 to 3.0 1.0 0.1

*On the SES60, the default value for all three fields is 0.
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zz PV bias

A calculated bias is reflected in the SI PV, Synth. Accel. PV, and M.V.E.V. PV.

Item name Setting Default value Set increments

SI PV bias −30.0 to +30.0 kine 0.0 kine 0.1 kine
Synth. Accel. PV bias −400.0 to +400.0 Gal 0.0 Gal 0.1 Gal
M.V.E.V. PV bias −3.0 to +3.0 0.0 0.1

zz N.P. Serious Fail Time

You can set the serious fail time caused by continued noise protect.

Settings range: 5 to 10080 min

Default value: 30 min

Setting increment: 1 min

zz NP lower threshold (only when in Full Setup)

The noise protect function operates based on multiple logics. One of these is a 
logic that treats the phenomenon of AC acceleration pulses in the positive or 
negative direction as noise. You can set the lower threshold for the AC accelera-
tion at which this logic operates.

Single axis ratio NP lower threshold: 1 to 200 Gal

Default value: 50 Gal

Setting increment: 1 Gal

Another is a logic that treats AC acceleration occurring in both the positive and 
negative directions as noise when the acceleration is limited to a single axis (X, 
Y, or Z) and there is little movement on the other axes. You can select whether 
or not to run this logic. If run, then you also set the lower threshold for the AC 
acceleration.

Select other axis ratio NP detection: Use/prohibit

Default value: Use

Other axis ratio Z-axis NP lower threshold: 1 to 200 Gal

Default value: 100 Gal

Setting increment: 1 Gal

Other axis ratio X/Y-axis NP lower threshold: 1 to 200 Gal

Default value: 50 Gal

Setting increment: 1 Gal
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zz Minor Failure Outp Choice (DO1)

You can set Liquef. Minor Failure Outp Choice (DO1) as Status/Minor Failure 
(Minor Failure Mode) or Minor Failure only. You also can set the output logic as 
positive or negative.

Default value: Status/Minor Failure, Positive Logic

zz Serious Fail. Outp Choice (DO2) [SES70 only]

You also can set the output logic for Serious Fail. Outp Choice (DO2) as positive 
or negative.

Default value: Positive Logic

zz Noise Outp Choice (DO3) [SES70 only]

You can set the output logic for Noise Outp Choice (DO3) as positive or 
negative.

Default value: Positive Logic

zz Communication settings

You can set the device address, RS-485 communications data format (parity 
check), and RS-485 communications transfer speed. The data format is fixed at 
a data length of 8-bit and a stop bit of 1-bit. Only parity (“None” or “Even”) can 
be selected.

Item name Setting Default value

Device address 0 to 126 1

RS-485 communication data format (parity) Select parity as “None” or “Even” Even

RS-485 communication transfer speed Select from 9600 bps, 19200 bps, or 38400 bps 38400 bps

Note: �With the SES60, both Loader Communication and RS-485 Communication are set. You also can select a transfer 
speed of 9600 or 19200 bps. (Default value: 19200 bps)

zz Liquefaction detection Enable/Disable (Full Setup only)

You can select to enable or disable liquefaction output.

Default value: Enabled

zz Reset settings (Full Setup only) [SES70 only]

You can press [F1] Reset Settings to reset the device settings to the default 
settings.

All settings other than communications settings are returned to their default 
values. All recorded waveforms and other data are deleted.

Be careful as once executed, this operation cannot be undone.

Executing this function also sends the device into Initialize mode.
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zz Acceleration filter (Full Setup only)

You can press [F2] Accel. Filter to select the filter value for both Calc. Accel. and 
Control Accel. Select from 3, 5, 7, 10, 20, 30, 50, or 100 Hz.

Calc. default value: 30 Hz

Control default value: 10 Hz

Note: ��Changing this setting will affect earthquake sensor operations. Make sure you 
fully understand the impact of changing these settings before making any 
changes. Executing this function also sends the device into Initialize mode.

zz ZCN Selection (Full Setup only)

You can press [F2] Accel. Filter to select Use/Prohibit for the ZCN detection. If 
you select “Use,” you then can set the ZCN time.

Default value: 20 s

Setting increment: 1 s

Executing this function also sends the device into Initialize mode.

The recommended value for ZCN time changes in correlation to the Cal. Accel. 
Filter value.

Make sure to adjust the ZCN time to the recommended setting.
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zz Output Selection (Full Setup only) [SES70 only]

You can press [F3] Output Selection to select between SES70 Output and SES60 
compatible output.

SES60 compatible output makes the following changes to the SES70 output to 
output a signal equivalent to the SES60.

Item SES70 output SES60 compatible output

J.V.D. J.V.D. 1, 2, 3 J.V.D. 1 only
Control output Control output 1, 2, 3 Control output 1 only
Minor Failure Outp.* Status/Minor Failure Status/Noise/Minor Failure
DO3 Output ON None
Maintenance sequence Phase 1 to 3 Phase 1 only

* �Status/Minor Failure for the Minor Failure Output function simply switches to the Status/Noise/Minor Failure function. 
The selected settings fields are not updated automatically. (For example, fields set to “Minor Failure Only” do not auto-
matically switch to “Status/Minor Failure”.) Make sure to change the settings fields as required.

Default value SES70 output

Executing this function also sends the device into Initialize mode.

Note:	 Simply changes the output function selection to “SES60 Compatible” but this does not provide the same 
exact operations as the SES60. Also change the following as necessary. (The following is a comparison 
with default values. Make the necessary changes if you have changed the default values.)

Item SES70 output SES60 compatible output

J.V.D. OR condition OR condition: None OR condition: SI value
J.V.D. AND condition AND condition: None AND condition: None
J.V.D. SI Threshold 300 kine 30 kine
J.V.D. Synth. Accel. Threshold 4000 Gal 300 Gal
J.V.D. M.V.E.V. threshold 7.9 5.3
Rec.Trigger Threshold Max. Wave (+Trigger Updating)
Max. Wave (+Trigger Updating) object SI value SI value
Max. Wave (− Trigger Updating) object SI value - (no function)
Threshold object SI value SI value
Threshold SI 1 kine 30 kine
Threshold - Synth. Accel. 5 Gal 300 Gal
Threshold - M.V.E.V 1.0 5.3
RS-485 communication speed 38400 bps 19200 bps
Minor Failure Outp Choice (DO1) Positive logic value Status/

Minor Failure
Positive logic value Status/Minor Failure 

(Function operates as Status/Noise/Minor Failure)
Serious Fail. Outp Choice (DO2) Positive logic Positive logic
SI PV low cut 1.0 kine 0.0 kine
Synth. Accel. PV low cut 5.0 Gal 0.0 Gal
M.V.E.V. PV low cut 1.0 0.0
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�� How to change settings
To change settings values, align the cursor (blue inverted character) with the 
content in the field you want to change in the Setup window and double-click.

There are three ways to input values as indicated below. the input method varies 
with each method.

(1) Select 
(2) Numeric input 
(3) Select + numeric input

After completing all input, press the [F7] Write Settings button. The changed 
values are written to the earthquake sensor memory. After writing settings to the 
memory, those values are read and monitored so you can confirm that the cor-
rect values have been written.

Make sure to write the settings to the memory. If you do not perform this mem-
ory write, the settings data will revert to the previous values once you reset the 
earthquake sensor or go to the Initialize screen.

zz How to input settings
(1)	 Double-click on a selection method, select the field you want to set from 

the pull-down, and then press the [Enter] key.

	

(2)	 Numeric input method
Click on the desired field line, input the desired values in half-width char-
acters, and then press the [Enter] key. For reference, you can align the cur-
sor with the value field to display the applicable value range at the bottom 
left of the screen. The field column becomes red to indicate an error if a 
value exceeding the applicable range is input. Make sure to input an ap-
propriate value.
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(3)	 Select + numeric input
Select the field you want to set from the pull-down, and then press the 
[Enter] key or input the numeric value and then press the [Enter] key. The 
precautions related to numeric value input are the same as the precautions 
for (2) Numeric Input.

	

 Handling Precautions
•	When inputting a value for the earthquake sensor, after inputting the value 

confirm that the appropriate value has been input.

•	 Inputting the incorrect value can result in performance that varies from 
customer expectations.

zz Aligning the internal sensor clock

(1)	 Press  [F6] Set Clock to set the internal sensor clock.
>> The settings screen is displayed.

		

(2)	 Set one of the following. 
>> �1: Auto: Aligned with PC internal clock 

2: �Manual: The following date and time settings area is displayed and 
allows you to manually input the settings.

(3)	 After inputting settings, click [OK]. To cancel, click [Cancel]. The system 
returns to the Setup window.
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zz To save settings

(1)	 Press [F4] Save File.
>> A file name input dialog box is displayed.

		

(2)	 Input the file name and click [Save] or press the [Enter] key.
>> The file is saved.

 Note
•	Other than the character string specified by the user, the settings file 

name is determined automatically.

XXXXXX_VVV_SNN.SE7

XXXXXX: Filename specified by the user

VVV: Version No. (xxxxxx)

S: Meaning of settings file

NN: 00 (fixed)

•	 If a file with the same name exists, the file is not overwritten. Instead, it is 
saved as a new file with a sequential version number.

•	The Save File function at the Setup screen only saves the settings file and 
does not save the waveform file.

•	To save the waveform file, conduct the file save process at the Record 
Waveform screen.

zz To open saved data

(1)	 Press [F5] File Open.
>> The Select File screen is displayed.
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(2)	 Select a file and click [OK].
>> A new window (offline mode) is launched.

 Note
•	There are multiple settings for the file type (*.SE6 and *.SE7).

•	*.SE6: Settings file saved using the previous version of the Loader 
(SLP-SE6).

•	*.SE7: Settings file saved using this Loader.

•	Either file type can be opened. However, only files saved as SES60 can be 
opened as *.SE6. (Not compatible with files saved as SES50/51/55.)

•	*.SE6 and *.SE7 settings files are a proprietary format that can only be 
viewed by the customer via the Loader.

zz To read settings data

(1)	 After inputting all settings, press [F7] Write Settings.
>> A confirmation screen is displayed.

		

(2)	 Click [Yes].
>> The settings are written and settings configuration is complete.

 Handling Precautions
•	Make sure to write the settings to the memory. If you do not press 

[F7] Write Settings, all the settings data except the clock data will revert 
to the previous values  once you reset the earthquake sensor or go to the 
Initialize screen.

zz Setting the earthquake sensor to Measurement mode

Press [F8] Return to return to the Top screen and then press [F7] Mode Change 
to switch to Initialize mode. After switching to Initialize mode, the system will 
transition to Measurement mode automatically.

 Handling Precautions
•	Please note that the SES60 may produce unstable analog output in Initialize 

mode.



4-19

Chapter 4.  FUNCTION OPERATIONS

In the main menu, press [F3] Record Waveform to switch to the List of Waveforms screen and display a list of 
recorded waveforms.

Or, you also can select [Top]>[Waveform]>[Waveform List] in the displayed menu tree.

When the earthquake sensor is in Measurement mode and you switch to the List of Waveforms screen, a mes-
sage will be displayed asking if you want to switch to Standby mode.

•	To change waveform recording conditions, click [Yes] and switch to Standby 
mode.

•	To confirm current waveform recording conditions, click [No] to change the 
screen without switching to Standby mode.

•	To cancel, click [Cancel]. The system will return to the Top screen.

When the earthquake sensor is in Measurement mode, normally calculation accelerations for three axes are 
stored in 12 buffers (auto waveform records 0 to 10, forced waveform record).

A single buffer can store a 10 ms sampling for a total of 360 s (36000 data). There also is a buffer for forced 
waveform records and while in Standby mode you can confirm whether or not the waveform is being recorded 
properly. In Standby mode, press [F6] Forced Rec. to force start waveform recording.

4 - 3 	 Record Waveform [F3]
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�� Displaying waveform data as a graph
In the List of Waveforms screen, press [F2] Wave Disp. to open a waveform 
display selection screen. Select the number of the waveform you want to display 
from the pull-down and click [OK].

You also can go to the waveform graph display window by double-clicking on 
the row of the waveform you want to display in the List of Waveforms screen.

At first, the entire waveform is displayed.

 Note
•	  Displaying simple trends (P. 4-4) for details on changing the wave-

form display width.

�� Displaying waveform data as numerical acceleration data
Click on [Numeric value] tab inside the graph display to display the waveform 
data as numeric figures.

Click the [Graph] tab to return to the wave form graph display window.

�� Confirming or changing recording conditions
In the List of Waveforms screen, press [F1] Rec. Cond. to switch to a screen dis-
playing the settings fields for recording conditions.

When the earthquake sensor is in Measurement mode, a message will be dis-
played asking if you want to switch to Standby mode.
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•	To change waveform recording conditions, click [Yes] and switch to Standby 
mode.

•	To confirm current waveform recording conditions, click [No] to change 
screens without switching to Standby mode .

•	To cancel, click [Cancel]. The system will return to the Top screen.

You can set the following fields at the Waveform Recording Conditions screen.

Refer to the Earthquake Sensor SES70 user manual (for design) for details on 
the characteristics of each method.

(1)	 Rec.Trigger:
You can select one of the following Rec.Trigger.
•	 Max. Wave (+Trigger Updating)
•	 Max. Wave (−Trigger Updating)
•	 Threshold

(2)	 Max. Wave (+Trigger Updating):
When you select Max. Wave (+Trigger Updating) as the Rec.Trigger in (1), 
select the maximum value object from among the following.
•	 SI value
•	 Synth. Accel.
•	 M.V.E.V

(3)	 Max. Wave (−Trigger Updating):
When you select Max. Wave (−Trigger Updating) as the Rec.Trigger in (1), 
select the maximum value object from among the following.
•	 SI value
•	 Synth. Accel.
•	 M.V.E.V
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(4)	 Threshold

When you select Threshold value format as the Rec.Trigger in (1), select 
the maximum value object from among the following.
•	 SI value
•	 Synth. Accel.
•	 M.V.E.V

(5)	 Threshold value

When you select Threshold value format as the Rec.Trigger in (1), set the 
threshold value for each threshold value object.

Settings fields and default values

Item name Setting Default value Set increments

Rec.Trigger Select from Max. Wave (+Trigger Updating) 
Max. Wave (−Trigger Updating) Threshold format

Threshold format —

Max. Wave (+Trigger Updating) 
object

Select from SI, Synth. Accel., or M.V.E.V. SI value —

Max. Wave (−Trigger Updating) 
object

Select from SI, Synth. Accel., or M.V.E.V. SI value —

Threshold object Select from SI, Synth. Accel., or M.V.E.V. SI value —

Threshold SI 1 to 300 kine 1 kine 1 kine

Threshold - Synth. Accel. 5 to 4000 Gal 5 Gal 1 Gal

Threshold - M.V.E.V 1.0 to 7.9 1.0 0.1

 Handling Precautions
•	The default values for SES70 waveform recording conditions have changed 

compared to the SES60. The changed content is as follows.

Default settings for waveform recording conditions (comparison with pre-
vious model)

Item SES70 SES50/51/55/60 
(Previous model)

Rec.Trigger Threshold Max. Wave 
(+Trigger Updating)

Max. Wave (+Trigger Updating) object SI value SI value

Max. Wave (−Trigger Updating) object SI value - (no function)

Threshold object SI value SI value

Threshold SI 1 kine 30 kine

Threshold - Synth. Accel. 5 Gal 300 Gal

Threshold - M.V.E.V 1.0 5.3

Note: �The purpose of changing the default value in the SES70 to the Threshold value 
was to record the most recent earthquakes and vibrations as well as to confirm 
stability for the setup location. Change this field to Max. Wave if you want to 
record the largest past vibrations.

•	Changing the recording conditions will require the deletion of all recording 
conditions. If an active waveform exists, the following screen will be dis-
played when you press [F7] Write Settings.

•	Delete the waveform prior to changing the waveform recording conditions.



4-23

Chapter 4.  FUNCTION OPERATIONS

•	Also, make sure to save any required waveforms prior to deleting them.

zz How to change waveform recording conditions

To change waveform recording conditions, align the cursor (blue inverted char-
acter) with the content in the field you want to change in the waveform record-
ing conditions window and double-click.

There are two ways to input values as indicated below. The input method varies 
with each method.

(1) Select 

(2) Numeric input

After inputting all waveform recording conditions, press the [F7] Write Settings 
button. The changed values are written to the earthquake sensor memory. After 
writing settings to the memory, those values are read and monitored so you can 
confirm that the correct values have been written.

Make sure to write the settings to the memory. If you do not perform this mem-
ory write, the waveform recording conditions will revert to the previous values 
once you reset the earthquake sensor or go to the Initialize screen.

zz How to input settings

(1)	 Double-click on a selection method, select the field you want to set from 
the pull-down, and then press the [Enter] key.

	
(2)	 Numeric input method

Click on the desired field line, input the desired values in half-width char-
acters, and then press the [Enter] key. For reference, you can align the cur-
sor with the value field to display the applicable value range at the bottom 
left of the screen. The field column becomes red to indicate an error if a 
value exceeding the applicable range is input. Make sure to input an ap-
propriate value.
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�� Making graphs easier to view
You can change the number of axis lines displayed if the graph displays of the X, 
Y, Z  axes overlap making the display difficult to view.

While displaying a graph, press [F3] Displayor right-click on the graph to display 
a list of display change options.

The operation method is the same as for Simple Trends so see  Displaying 
simple trends (P. 4-4) for details.

�� About SV Record Display (Full Setup only) [SES70 only]
During waveform recording, you can display the SV value (speed response value 
for each fixed cycle) calculated during the SI value calculation process.

Press [F4] SV Record Display. The following screen is displayed.

The SV value (SV1 to SV7) is displayed for the seven fixed cycles of each re-
corded wave. The error flags for each waveform recording are also displayed.

If SI Value 2 (24 fixed cycles, 16-direction projection) is selected for the SI calcu-
lation, you can select which 7 fixed cycles are displayed from among the 24 fixed 
cycles.

At the SV Record Display screen, press [F1] Select SV Record Object.

If in Measurement mode when switching to the Select SV Record Object screen, 
the following screen is displayed and you must return to Standby mode.
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Here, the following screen is displayed if SI Value 1 is selected for the SI calcula-
tion and you cannot change the SV record object.

If in Standby mode and SI Value 2 is selected for the SI calculation, pressing 
[F1] Select SV Record Object button will display the following screen and you 
can select the fixed cycles for the SV record object.

At this screen, select the 7 fixed cycles that you want to record from among the 
24 fixed cycles for SI Value 2.

The wave form information is recorded for the selected fixed cycles in order of 
smallest first (SV1, SV2, SV3... SV7).

�� Saving waveform data to PC
You can save all enabled waveforms displayed in the List of Waveforms to the 
PC. (You cannot select and save desired waveforms.)

When you save waveform data, the settings change file is also saved. (Be careful 
as the waveform data is not saved if you save the settings change file from the 
Setup screen.)

zz Information saved when the waveform record is saved

(1)	 Waveform data: Maximum 11 waves (10 auto-record waveforms + 1 forced 
record waveform)

(2)	 Earthquake sensor settings file
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How to save

(1)	 Press [F5] Save File.

>> A file name input dialog box is displayed.

		

(2)	 Input the file name and click [Save] or press the [Enter] key.

>> �The file is saved. The save file function is available only on online mode 
when the earthquake sensor is connected to this Loader.

The time required for file save will vary depending on the number of waveforms 
and communications speed. The approximate times are as follows.

•	Loader communication (communications speed 115200 bps, all 11 waves): 
Approx. 6 min

•	RS-485 communication (communications speed 38400 bps, all 11 waves): 
Approx. 14 min

 Note
•	When you save waveform file data, the settings file data is saved 

automatically.

�� About the file name of the saved file

zz File save location

The default (standard folder) is as follows. To change the save location, click 
“Change Folder” to set the save location. Click [Standard Folder] button to 
reselect the standard folder after changing the folder.

l Default (standard folder)

C:\Users\username\Documents\slp\SlpSe7\data
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zz Filename

The file name is as shown below. Other than the character string specified 
by the user, the file name is determined automatically.

l Filename: name_VVV_*00.***

Name: filename specified by the user
VVV: Version number (for each name)
*00: Data type

W00 to 11 > �Waveform data (number is the same as the page 
number)

S00> settings file
***: Extension

CSV > waveform data
SE7 > Loader-only file

Note:	 If a file with the same name exists, the file is not overwritten. Instead, 
it is saved as a new file with a sequential version number.

zz File format

(1) Waveform data:	Saved as CSV file. The waveform header information 
and the acceleration for the X, Y, and Z axes are saved. 
This information can be viewed using Excel, etc.

(2) Settings file:	 File is saved with the “.SE7” extension (“***.SE7”). You 
can use the Loader (offline) to view the data. This con-
tent is not published.

�� Manually recording waveform data
This function enables the manual recording of waveform data. Use when you 
want to confirm the status of acceleration measurement.

Press [F6] Force Record to begin the manual recording (forced record) of the 
waveform. This waveform is recorded for a period of 360 s after the start record 
command is issued to the force record buffer.

(1)	 Press [F6] Force Record

>> �When the earthquake sensor is in Standby mode, a confirmation screen 
is displayed.
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The following screen is displayed if the earthquake sensor is in Measurement 
mode. Click [Yes] to switch to Standby mode. Then the above confirmation 
screen is displayed.

(2)	 Click [OK].

>> The forced recording of the waveform is started.

 Note
•	You can confirm the status of the waveform during and after recording in 

display area F*.

During recording waveform

After recording waveform

Note:    3-1 Basic Operations (P. 3-2) for information on the display area.
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�� Deleting waveform data
(1)	 Press [F7] Delete Waveform to delete all waveforms.

>> �When the earthquake sensor is in Standby mode, a confirmation screen 
is displayed.

		

The following screen is displayed if the earthquake sensor is in Measurement 
mode. Click [Yes] to switch to Standby mode. Then the above confirmation 
screen is displayed.

(2)	 Click [OK].

>> All waveform data is deleted.

�� About waveform data content
Waveform data saved via this Loader is saved as a CSV file.

The file contains waveform header information and the acceleration for the X, Y, 
and Z axes. You can use Microsoft Excel or other spreadsheet application to view 
the file.
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You can select [F5] Manual Output in the main menu to force the output of selected values for the earthquake 
sensor's output ports (AO, DO, Control).

With the earthquake sensor in Standby mode, press [F5] Manual Output in the main menu or select Manual 
Output in the displayed menu tree to display the Manual Output/Setup screen.

When the earthquake sensor is in Measurement mode, a message will be displayed asking if you want to switch 
to Standby mode.

•	To conduct manual output, click [Yes] and switch to Standby mode.

•	To view the Manual Output screen, click [No] to change screens without 
switching to Standby mode.

•	To cancel, click [Cancel]. The system will return to the Top screen.

zz Manual output screen

You can use this function to conduct an external device test.

Double-click on “Manual Output Selection” in the Manual Output screen. 
“Auto,” “PV Manual Output,” “AO/DO Manual Output” are displayed in the pull-
down menu. Select the item you want to change and press [ENTER].

After completing all input, press the [F7] Output Confirmation button. The 
changed values are written to the earthquake sensor memory. After writing set-
tings to the memory, those values are read and monitored so you can confirm 
that the correct values have been written.

Select “Auto” to disable manual output.

4 - 4 	 Manual output [F5]
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zz How to conduct manual output

The two following ways allow you to conduct manual output

zz PV Manual Output:

The following PV are output manually.
•	 SI (PV) •	 M.V.E.V. (PV)
•	 Synth. Accel. (PV) •	 Liquef. (PV)

The PV are output manually, so the corresponding AO and DO output is 
also conducted. (For example, the control output is set to ON/OFF based on 
the J.V.D. threshold.)

PV Manual Output

Item name Setting Default value Set increments

SI (PV) 0 to 300 kine * 1 kine
Synth. Accel. (PV) 0 to 4000 Gal * 1 Gal
M.V.E.V (PV) 0 to 7.9 * 0.1
Liquef. (PV) Enable/Disable * —

* �The default value is the output value based on the setting for “PV Manual Output” set 
under Manual Output Selection.

zz AO/DO Manual Output:

The following AO/DO/Control Output are output manually.
•	 AO1 manual output •	 DO1 Output
•	 AO2 manual output •	 DO2 Output
•	 Control output 1, 2, 3 •	 DO3 Output

•	 DO4 Output
AO Manual output

Item name Setting Default value Set increments

AO1 Manual output −10.0 to 110.0% * 0.1%
AO2 Manual output −10.0 to 110.0% * 0.1%

* �The default value is the output value based on the setting for “AO/DO Manual Output” 
set under Manual Output Selection.

Control Output

Item name Setting Default value Set increments

Control Output 1 ON/OFF * —
Control Output 2 ON/OFF * —
Control Output 3 ON/OFF * —

* �The default value is the output value based on the setting for “AO/DO Manual Output” 
set under Manual Output Selection.

DO Output

Item name Setting Default value Set increments

DO1 Output ON/OFF/Flash *1 —
DO2 Output ON/OFF *1 —
DO3 Output ON/OFF *1 —
DO4 Output ON/OFF/Flash *2 *1 —

*1. �The default value is the output value based on the setting for “AO/DO Manual 
Output” set under Manual Output Selection.
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*2. �The terminal status is Slow ON/OFF

•	Set the internal judgment for DO output. As such, if negative logic is selected 
for DO1 Output, DO2 Output, or DO3 Output, the set values may differ from 
the status of the actual DO terminal. The following indicates the correlation 
between the set values and the actual terminal status.

Item Manual output Setting
SES70 terminal status

Positive logic Negative logic

Minor failure 
(DO1)

OFF OFF ON

ON ON OFF

Blinking Slow ON/OFF Slow ON/OFF

Serious failure 
(DO2)

OFF OFF ON

ON ON OFF

Noise protect 
(DO3)

OFF OFF ON

ON ON OFF

zz How to input settings

zz a selection method

Double-click on a selection method, select the field you want to set from the 
pull-down, and then press the [Enter] key.

zz Numeric input method

Click on the desired field line, input the desired values in half-width characters, 
and then press the [Enter] key. For reference, you can align the cursor with the 
value field to display the applicable value range at the bottom left of the screen. 
The field column becomes red to indicate an error if a value exceeding the appli-
cable range is input. Make sure to input an appropriate value.
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This function allows you to run a self-diagnosis for the accelerator pickup and perform a zero-adjust on the 
accelerator.

With the earthquake sensor in Standby mode, press [F6] Diagnosis in the main menu or select [Diagnosis] > 
[Diagnosis] in the displayed menu tree to display the Diagnosis screen.

When the earthquake sensor is in Measurement mode, a message will be displayed asking if you want to switch 
to Standby mode.

•	To run the diagnosis, click [Yes] and switch to Standby mode.

•	To view Diagnosis screen details, click [No] to change the screen without 
switching to Standby mode.

•	To cancel, click [Cancel]. The system will return to the Top screen.

4 - 5 	 Diagnosis Function [F6]
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�� Pickup diagnosis
(1)	 Press [F3] Diagnosis to run the earthquake sensor pickup diagnosis.

>> �A confirmation screen is displayed.

		

The following screen is displayed if the earthquake sensor is in 
Measurement mode. Click [Yes].

		

(2)	 Click [OK].

>> �During diagnosis, the pickup operating status switches to “Diagnosing.” 
Once finished, “Finished” is displayed and the diagnosis results are 
shown on the screen.

Running Diagnosis screen 



4-35

Chapter 4.  FUNCTION OPERATIONS

Diagnosis Complete screen (for normal complete)

Diagnosis Complete screen (when an error is discovered)

If an error is discovered, “ON” is displayed under “Diagnosis Alarm.”

	

 Handling Precautions
•	After starting the diagnosis, error flag noise is produced and “Noise Protect” 

is displayed in display area K* at the bottom of the screen. This is not an 
error. This operation is forcefully mimicking acceleration pickup during the 
diagnosis. This will stop approximately 100 s after the start of the diagnosis.

*�  3-1 Basic Operations (P3-2) for information on the display area.
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�� Zero-Adjust (Full Setup)
(1)	 Press [F4] Auto Bias to automatically correct the acceleration to zero.

>> A confirmation screen is displayed.

		

(2)	 Click [OK].

After adjustment, the acceleration (adjusted) field value is close to 0 to in-
dicate that the value has been adjusted.

(3)	 Press [F7] Write Settings to write the adjusted value to the earthquake 
sensor. The changed values are written to the earthquake sensor memory. 
After writing settings to the memory, those values are read and monitored 
so you can confirm that the correct values have been written.

	 Make sure to write the settings to the memory. If you do not perform this 
memory write, the zero-adjust value will revert to the previous values once 
you reset the earthquake sensor or go to the Initialize screen.

 Handling Precautions
•	 In some cases, “Noise Protect” is displayed at the bottom of the screen in 

display area G during the adjustment. This is not an error. This operation 
is forcefully adjusting the acceleration to zero. The Noise Protect status 
will disappear approximately 100 s after the start of the adjustment. 
However, as the AC acceleration is not changed via the zero-adjust, this 
has no impact on the Synth. AC Accel., SI, M.V.E.V., or Liquef. Judg. values 
used as controls. As such, normally this is not used. Zero-adjust cannot be 
conducted once the acceleration adjustment value calculation reaches 
±150 Gal.
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Press [F7] Mode Change in the main menu or select Mode Change in the displayed menu tree to display the 
Mode Change screen.

Here, you change the earthquake sensor mode.

1: Initialize mode

2: Measurement mode

3: Standby mode

4: Maintenance mode

Check the radio button of the desired mode and then click [OK].

>> The mode is changed and the dialog box will close.

Select Initialized mode when you want to change to Measurement mode.

Note:	 If a serious failure has occurred, the system will go to Standby mode auto-
matically and will not go into Measurement mode.

 Handling Precautions
•	Please note that the SES60 may produce unstable analog output in 

Initialize mode.

zz Maintenance mode

Maintenance mode runs the earthquake sensor relay output and AO/DO output 
in a predetermined sequence to confirm the stability of the earthquake sensor 
and system.

The Maintenance mode sequence runs sequentially in phases 1 through 3. 
Screen operation is required to proceed to the next phase.

zz Switching to Maintenance mode

With the earthquake sensor in Measurement mode, press [F7] Mode Change in 
the menu screen. Select Maintenance from the Mode Change screen and click 
[OK]. A screen confirming you want to switch to Maintenance mode is dis-
played. Click [Yes].

This initiates Maintenance mode phase 1.

4 - 6 	 Mode Change [F7]
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zz Maintenance mode: Phase 1
Running: You cannot operate the Loader while running Maintenance mode 
phase 1.

Execution completed: After phase 1 ends, you can select whether to run phase 2 
or to exit Maintenance mode.

Click [Next] to run phase 2.

Click [Cancel] to exit Maintenance mode. Exiting will send the earthquake sen-
sor into Initialize mode.

zz Maintenance mode: Phase 2
Similar to phase 1, after phase 2 ends, you can select whether to continue onto 
phase 3 or to exit Maintenance mode.

Select whether you want to continue onto phase 3 or to exit.

zz Maintenance mode: Phase 3
Once phase 3 is ends, the only selection option is the [Cancel] button. Click 
[Cancel] to exist Maintenance mode. Exiting will send the earthquake sensor 
into Initialize mode.
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�� List of Error Messages
In the event of a key operation error, an error message is displayed in a message 
box or in display area K*. The methods for responding to these messages are 
shown below. 

*�  3-1 Basic Operations (P. 3-2) for information on the display area.

Message Countermeasure

No name specified for the save file. Input a filename. 

Waveform updated during read. Process canceled. The record waveform process was executed during the read 
waveform process and the specified waveform was updated. 

Confirm the waveform information from the List of Waveforms.

Waveform disabled during read. Process canceled. The record waveform process was executed during the read 
waveform process and the specified waveform was disabled.

Confirm the waveform information from the List of Waveforms.

Mode is not Measurement mode. 

Waveform auto-record not allowed. 

Exit? 

The earthquake sensor is attempting to exit the Loader while 
in a mode other than Measurement mode. Normally, switch to 
Measurement mode, the mode in which waveform auto-record 
is executed, and then exit. 

Serious failure

Noise protect

Minor failure

Typical errors produced by the earthquake sensor. 

Confirm error details and refer to the user manual for 
troubleshooting. 

File cannot be opened. Invalid changes were made or 
the file is damaged. 

There is a possibility the settings file is damaged or the file is 
not correct. Reread the file or 

specify the correct file. 

USB loader cable not inserted. Connect the USB loader cable to the PC.

Connection with earthquake sensor failed. The fol-
lowing are possible causes. 
•	Error in communication transmission settings 
•	Earthquake sensor not connected 

Startup offline 

Communications not possible. Confirm that the communica-
tions line (cable or terminal) is connected to the earthquake 
sensor.  
Also confirm communications settings. 

Error in settings (row number) 

Change the settings and redo the write settings 
operation. 

Error in set field. Confirm settings details. 

Communications error occurred during connection 
with the earthquake sensor. 

Exiting program.

Restart the program and confirm communications. 

Contact us if this error occurs again. 

Acceleration adjustment value is ±150 Gal or higher. 

Zero-adjust not allowed. 

Confirm settings details.

The earthquake sensor is tiled too far and zero-adjust is not pos-
sible. Redo device setup. 

Cannot write during Loader communication. 

Remove the USB loader cable from the SES and retry. 

USB loader cable inserted during RS-485 communication with 
earthquake sensor. Remove the USB loader cable from the SES 
and retry.

Cannot open help file. Confirm that Acrobat Reader is 
installed or that the help file exists. 

Confirm that Acrobat Reader is installed. Confirm that the help 
file exists.

Files required for Loader operation not found. 

Reinstall the Loader. 

Reinstall the Loader.

USB loader cable COM port number not selected. Select a USB loader cable COM port number from the 
Communications Settings screen. 
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Message Countermeasure

RS-485 communication COM port number not 
selected.

Select a RS-485 communication COM port number from the 
Communications Settings screen.

Active waveform exists. Cannot write the waveform 
recording settings. 

Delete the waveform prior to changing the waveform 
recording settings.

Delete the waveform prior to changing the waveform recording 
condition.

Cannot start diagnosis because diagnosis is running. Conduct operation after the diagnosis is finished. 

Conduct operation after changing to Measurement 
or Standby mode. 

Conduct operation after changing to Measurement mode or 
Standby mode.

Change to Standby mode. Currently in mode other than Standby mode. Change to 
Standby mode at the Change Mode screen. 

Communications timeout error occurred during con-
nection with the earthquake sensor.

Exiting program.

Confirm that the earthquake sensor power is ON and that 
the loader cable or RS-485 communications line is connected 
properly. 

Target waveform record file does not exist. Specified waveform record file does not exist. Specify the cor-
rect waveform file.

System changed to mode other than Maintenance 
mode. Canceling operation and returning to main 
menu. 

The earthquake sensor mode was changed while in 
Maintenance mode. Reset the system to Maintenance mode 
from the Change Mode screen. 

No data changes input. Exit settings without making 
changes? 

Execute the Write Settings function to apply data changes. 

No data changes will be input if you exit now? Exit? Execute the Write Settings function to apply data changes.

After the zero-adjust, write the adjusted values to the earth-
quake sensor before exiting. 

Still in Manual Output. Measurement and calculation 
results will not be reflected in PV, output, etc. Exit this 
window? 

PV, output, etc. are still in Manual Output. To set to normal mea-
surement and calculation status, select Auto Output or switch 
to Measurement mode. 

Connection with earthquake sensor failed. Model 
number of the connected earthquake sensor not 
compatible. 

Startup offline

The connected earthquake sensor is a model other than SES70/
SES60. Connect an SES70 or SES60. 

Cannot switch to Measurement mode. Confirm the 
status of the SES. 

A serious failure occurred in Initialize mode when changing 
modes. 

Confirm the status of the earthquake sensor. 

Cannot open or read waveform file of specified page. 
Exiting. 

File is damaged. Specify the correct file.

Mode change failed. 

Retry operation. 

Retry the mode change. 

Phase change failed.

Retry operation.

Retry running Maintenance mode. 

Model other than SES70/60. 

Cannot open file.

The specified file is for a model other than SES70/SES60. Specify 
a file for SES70 or SES60.

No data changes input. Changing display will revert 
data to figures prior to changes. 

Change display without writing data?

Execute the Write Settings function to apply data changes.

After the zero-adjust, write the adjusted values to the earth-
quake sensor before exiting.

Invalid page. Cannot display waveform. Specify a valid page. 

Incorrect mode. Cannot continue write operation. 

Check the operating mode and retry. 

Check the operating mode and retry.
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�� Troubleshooting confirmed errors 
 4-1 Monitor [F1] (P. 4-1) to check the error status. Use the following pro-

cedures if “Yes” is indicated in the column.

General error information Description Countermeasure

Sensor memory 
(Serious failure)

Memory content or read 
error 

Confirm error details and then reboot 

This may result in the deletion of waveform record data. 

Contact us if the problem occurs again. 

A/D Converter 
(Serious failure)

A/D converting part error Confirm error details and then reboot

Contact us if the problem occurs again.
Sensor clock H/W 
(Serious failure)

Operational error by the 
internal clock 

Output relay 
(Serious failure)

Control Output circuit error An error was detected in the control output circuit of the 
earthquake sensor. 

Replace the earthquake sensor.

Other H/W 
(Serious failure)

Other H/W errors Confirm error details and then reboot

Contact us if the problem occurs again.

Accelerometer 
(Serious failure)

Acceleration pickup diagno-
sis output error 

Confirm error details and then reboot

Run pickup diagnosis. 

Contact us if the problem occurs again.

Accel. Value 
(Serious failure)

Acceleration value error Confirm error details and earthquake sensor setup status 
and then reboot. 

Contact us if the problem occurs again.

Inclination Accel. (Serious) 
(Serious failure)

Earthquake sensor leveling 
error 

Same as above 

Accel. noise continuous 
(Serious failure)

Continuous non-vibration 
waveform error 

Confirm error details and then reboot

Contact us if the problem occurs again.

Battery level 
(Minor failure)

Battery voltage decline 
error 

Replace with a new battery 

Refer to “SES60 Intelligent Earthquake Sensor User's 
Manual For System Design (CP-SP-1156E)” for replacement 
procedures. 

Contact us if the problem occurs again.

Temperature (Minor)/  
Temperature (Serious) 
(Minor failure)/(Serious 
failure)

Earthquake sensor internal 
temperature error

Turn device OFF, confirm that the ambient temperature is 
normal, and then reboot. 

Contact us if the problem occurs again.

Sensor clock data 
(Minor failure)

Internal clock data error Confirm that the earthquake sensor internal clock is set to 
the correct time. 

Contact us if the problem occurs again.

Inclination Accel. (Minor) 
(Minor failure)

Earthquake sensor leveling 
error

Confirm error details and earthquake sensor setup status 
and then reboot.

Contact us if the problem occurs again.

Accel. Noise 
(Noise protect)

Non-vibration waveform 
detection error 

Wait for approximately 100 s. 

Contact us if the problem does not disappear or occurs 
frequently.
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�� Other

Phenomenon Countermeasure

After the loader was installed on Windows 10, the 
SLP-SE7 (SES70) icon for starting up the loader is not 
displayed on the desktop.

Reinstall the loader .  Installing the Loader (P. 1-5)

During the process, make sure to select [All users] on the [Make 
short-cut on desktop] screen in step 7.

After the loader was installed on Windows 10, the 
SLP-SE7 (SES70) icon for starting up the loader is not 
displayed by clicking Start → [SLP].

Depending on the account privileges of the user who installed 
the loader , the icon may not be generated.

Start the loader from the SLP-SE7 (SES70) icon on the desktop.
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�� Explanation of terminology 
A description of the terminology used in user manuals related to the Intelligent 
Earthquake Sensor SES70 is provided below. 

Terminology Description

Acceleration 

Pickup diagnosis

Acceleration detection element mounted in the device. 

Able to detect 3-axis directions X, Y, Z 
SI value Numeric value correlated to earthquake damage  Unit kine = cm/s

The actual read value and output value are the maximum values for a 10 to 20 second period. 

SI value 1: 8-direction, 7 fixed cycle SI calculation 

SI value 2: 16-direction, 24 fixed cycle SI calculation
Synth. AC Accel. Horizontal plane 2-axis or 3-axis vector synthetic AC acceleration unit Gal=cm/s2. The actual read 

value and output value are the maximum values for a 10 to 20 second period.
M.V.E.V Damage measurement value calculated using the SI value only or using a relative equation based 

on the SI value and the synthetic AC acceleration 
Characterization 
correction 

Uses temperature sensor values to correct the acceleration pickup output temperature characteris-
tics to improve the accuracy of the measured acceleration. 

Calculation 
acceleration

Acceleration value containing frequency domain required for SI and M.V.E.V. calculation. 

Also used in waveform recording and the synthetic AC acceleration PV. 
Control Accel. Acceleration value cut at a higher frequency domain compared to the Calculation Accel. in order to 

reduce background noise for AO, monitoring, etc. 
Adjusted Accel. Acceleration adjusted for bias. 
Inclination Accel. Value representing static acceleration factoring in temperature drift and inclination due to setup 

conditions. 
AC Accel. Value representing dynamic acceleration (=adjusted acceleration - inclination acceleration) 
J.V.D. J.V.D. status initiated when values set for SI and Synth. Accel. are exceeded and output conditions 

are satisfied. 
Control Output When J.V.D. Condition is fulfilled and there is no error status, the control output relay is set to ON. 
Liquef. (PV) Liquef. detect status is enabled when the SI, Synth. Accel., estimate variance, and zero-cross count 

Liquef. (PV) conditions are fulfilled. 
Liquefaction 
Output

When J.V.D. Condition is fulfilled and there is no error status, the Lique. control output DO3 is set to 
ON.

Record waveform There are two functions: auto-record (10 waveforms) and force record (1 waveform). 
Error diagnosis Four types of errors are detected: reset, serious failure, minor failure, and noise detection. 
Reset Reset is conducted in the event of a serious failure, which can impact all functions. 
Serious failure Error status that can impact control output, liquefaction output, and other control functions. 

Serious failure output is set to ON and control output is set to OFF. 
Minor failure Error status with no impact on control output but requires confirmation of waveform record and 

clock data retention status, clock data errors, and setup conditions. 

Minor failure output set to ON. 
Noise detection 

Noise protect

Status for detection of non-seismic signals that can impact calculation results. 

PV values set to 0 or OFF and minor failure flashes. 
Maintenance 

Sequence

The output status in Maintenance mode will change depending on the sequence. This makes it pos-
sible to check operations of externally connected instruments. 

Pickup diagnosis Physically operates pickups via the diagnosis circuit to detect pickup operation errors. 
Auto bias Automatically adjusts the bias value using the Loader. 
FSG Acceleration range subject to performance guarantee: 1960 Gal (weighted acceleration standard 

±980 Gal) span value. 
%FSG 1960 Gal span percentage (±2 %FSG = ±39.2 Gal)
FSO Measurable acceleration range: 4000 Gal span value (±2000 Gal) 
%FSO 4000 Gal span percentage (±2 %FSO = ±80 Gal)
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�� How to set the SES70 to the same output method as the SES60 (SES60 compat-
ibility function) 

You can change the following settings to  set the SES70 to perform the same op-
erations as the SES60. (The following is a comparison with default values. Make 
the necessary changes if you have changed the default values.)

Item SES70 output SES60 compatible output

Select output function SES70 output SES60 compatible output

J.V.D. OR condition

J.V.D. AND condition

OR condition: None

AND condition: None

OR condition: SI value

AND condition: None

J.V.D. SI Threshold 300 kine 30 kine

J.V.D. Synth. Accel. Threshold 4000 Gal 300 Gal

J.V.D. M.V.E.V. threshold 7.9 5.3

Rec.Trigger Threshold − Max. Wave (+ Trigger Updating)

Max. Wave (+ Trigger Updating) 
object

SI value SI value

Max. Wave (− Trigger Updating) 
object

SI value — (no function)

Threshold object SI value SI value

Threshold SI 1 kine 30 kine

Threshold - Synth. Accel. 5 Gal 300 Gal

Threshold - M.V.E.V 1.0 5.3

RS-485 communication speed 38400 bps 19200 bps

Minor Failure Outp Choice (DO1) Positive logic value Status/Minor Failure Positive logic value Status/Minor Failure 
(Functions as Status/Noise/Minor Failure) 

Serious Fail. Outp Choice (DO2) Positive logic Positive logic

SI PV low cut 1.0 kine 0.0 kine

Synth. Accel. PV low cut 5.0 Gal 0.0 Gal

M.V.E.V. PV low cut 1.0 0.0
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We would like to express our appreciation for your purchase and use of Azbil Corporation’s products. 

You are required to acknowledge and agree upon the following terms and conditions for your purchase of Azbil Corporation’s products (system 
products, field instruments, control valves, and control products), unless otherwise stated in any separate document, including, without limitation, 
estimation sheets, written agreements, catalogs, specifications and instruction manuals. 

1. Warranty period and warranty scope

1.1 Warranty period

Azbil Corporation’s products shall be warranted for one (1) year from the date of your purchase of the said products or the delivery of the 
said products to a place designated by you.

1.2 Warranty scope

In the event that Azbil Corporation’s product has any failure attributable to azbil during the aforementioned warranty period, Azbil 
Corporation shall, without charge, deliver a replacement for the said product to the place where you purchased, or repair the said 
product and deliver it to the aforementioned place.  Notwithstanding the foregoing, any failure falling under one of the following shall 
not be covered under this warranty: 

(1) Failure caused by your improper use of azbil product (noncompliance with conditions, environment of use, precautions, etc. set 
forth in catalogs, specifications, instruction manuals, etc.); 

(2) Failure caused for other reasons than Azbil Corporation’s product;
(3) Failure caused by any modification or repair made by any person other than Azbil Corporation or Azbil Corporation’s 

subcontractors;  
(4) Failure caused by your use of Azbil Corporation’s product in a manner not conforming to the intended usage of that product; 
(5) Failure that the state-of-the-art at the time of Azbil Corporation’s shipment did not allow Azbil Corporation to predict; or 
(6) Failure that arose from any reason not attributable to Azbil Corporation, including, without limitation, acts of God, disasters, and 

actions taken by a third party. 

Please note that the term “warranty” as used herein refers to equipment-only-warranty, and Azbil Corporation shall not be liable for any 
damages, including direct, indirect, special, incidental or consequential damages in connection with or arising out of Azbil Corporation’s 
products. 

2. Ascertainment of suitability 

You are required to ascertain the suitability of Azbil Corporation’s product in case of your use of the same with your machinery, 
equipment, etc. (hereinafter referred to as “Equipment”) on your own responsibility, taking the following matters into consideration: 

(1) Regulations and standards or laws that your Equipment is to comply with.
(2) Examples of application described in any documents provided by Azbil Corporation are for your reference purpose only, and 

you are required to check the functions and safety of your Equipment prior to your use. 
(3) Measures to be taken to secure the required level of the reliability and safety of your Equipment in your use 

Although azbil is constantly making efforts to improve the quality and reliability of Azbil Corporation’s products, there exists 
a possibility that parts and machinery may break down.  You are required to provide your Equipment with safety design such 
as fool-proof design,*1 and fail-safe design*2 (anti-flame propagation design, etc.), whereby preventing any occurrence of 
physical injuries, fires, significant damage, and so forth. Furthermore, fault avoidance,*3 fault tolerance,*4 or the like should be 
incorporated so that the said Equipment can satisfy the level of reliability and safety required for your use. 

*1. A design that is safe even if the user makes an error. 
*2. A design that is safe even if the device fails. 
*3. Avoidance of device failure by using highly reliable components, etc. 
*4. The use of redundancy. 

3. Precautions and restrictions on application 

3.1 Restrictions on application

Please follow the table below for use in nuclear power or radiation-related equipment. 

Nuclear power quality*5 required Nuclear power quality*5 not required

Within a radiation 
controlled area*6

Cannot be used (except for limit switches for 
nuclear power*7)

Cannot be used (except for limit switches for 
nuclear power*7)

Outside a radiation 
controlled area*6

Cannot be used (except for limit switches for 
nuclear power*7)

Can be used

*5. Nuclear power quality: compliance with JEAG 4121 required
*6.  Radiation controlled area: an area governed by the requirements of article 3 of “Rules on the Prevention of Harm from 

Ionizing Radiation,” article 2 2 4 of “Regulations on Installation and Operation of Nuclear Reactors for Practical Power 
Generation,” article 4 of “Determining the Quantity, etc., of Radiation-Emitting Isotopes,”etc.

*7.  Limit switch for nuclear power: a limit switch designed, manufactured and sold according to IEEE 382 and JEAG 4121.

Any Azbil Corporation’s products shall not be used for/with medical equipment.

The products are for industrial use. Do not allow general consumers to install or use any Azbil Corporation’s product. However, azbil 
products can be incorporated into products used by general consumers. If you intend to use a product for that purpose, please contact 
one of our sales representatives. 

3.2 Precautions on application

you are required to conduct a consultation with our sales representative and understand detail specifications, cautions for operation, 
and so forth by reference to catalogs, specifications, instruction manual, etc. in case that you intend to use azbil product for any purposes 
specified in (1) through (6) below.  Moreover, you are required to provide your Equipment with fool-proof design, fail-safe design, anti-
flame propagation design, fault avoidance, fault tolerance, and other kinds of protection/safety circuit design on your own responsibility 
to ensure reliability and safety, whereby preventing problems caused by failure or nonconformity. 

Terms and Conditions



(1) For use under such conditions or in such environments as not stated in technical documents, including catalogs, specification, 
and instruction manuals 

(2) For use of specific purposes, such as: 
*  Nuclear energy/radiation related facilities  

[When used outside a radiation controlled area and where nuclear power quality is not required]  
[When the limit switch for nuclear power is used]

* Machinery or equipment for space/sea bottom 
* Transportation equipment 
 [Railway, aircraft, vessels, vehicle equipment, etc.] 
* Antidisaster/crime-prevention equipment 
* Burning appliances 
* Electrothermal equipment 
*  Amusement facilities 
* Facilities/applications associated directly with billing 

(3) Supply systems such as electricity/gas/water supply systems, large-scale communication systems, and traffic/air traffic control 
systems requiring high reliability 

(4) Facilities that are to comply with regulations of governmental/public agencies or specific industries 
(5) Machinery or equipment that may affect human lives, human bodies or properties 
(6) Other machinery or equipment equivalent to those set forth in items (1) to (5) above which require high reliability and safety 

4. Precautions against long-term use 

Use of Azbil Corporation’s products, including switches, which contain electronic components, over a prolonged period may degrade 
insulation or increase contact-resistance  and may result in heat generation or any other similar problem causing such product or switch 
to develop safety hazards such as smoking, ignition, and electrification. Although acceleration of the above situation varies depending 
on the conditions or environment of use of the products, you are required not to use any  Azbil Corporation’s products for a period 
exceeding ten (10) years unless otherwise stated in specifications or instruction manuals. 

5. Recommendation for renewal

Mechanical components, such as relays and switches, used for Azbil Corporation’s products will reach the end of their life due to wear by 
repetitious open/close operations.  

In addition, electronic components such as electrolytic capacitors will reach the end of their life due to aged deterioration based on 
the conditions or environment in which such electronic components are used. Although acceleration of the above situation varies 
depending on the conditions or environment of use, the number of open/close operations of relays, etc.  as prescribed in specifications 
or instruction manuals, or depending on the design margin of your machine or equipment, you are required to renew any Azbil 
Corporation’s products every 5 to 10 years unless otherwise specified in specifications or instruction manuals.  System products, field 
instruments (sensors such as pressure/flow/level sensors, regulating valves, etc.) will reach the end of their life due to aged deterioration 
of parts.  For those parts that will reach the end of their life due to aged deterioration, recommended replacement cycles are prescribed. 
You are required to replace parts based on such recommended replacement cycles. 

6. Other precautions

Prior to your use of Azbil Corporation’s products, you are required to understand and comply with specifications (e.g., conditions and 
environment of use), precautions, warnings/cautions/notices as set forth in the technical documents prepared for individual Azbil 
Corporation’s products, such as catalogs, specifications, and instruction manuals to ensure the quality, reliability, and safety of those 
products. 

7. Changes to specifications 

Please note that the descriptions contained in any documents provided by azbil are subject to change without notice for improvement 
or for any other reason.  For inquires or information on specifications as you may need to check, please contact our branch offices or 
sales offices, or your local sales agents. 

8. Discontinuance of the supply of products/parts

Please note that the production of any Azbil Corporation’s product may be discontinued without notice. After manufacturing is 
discontinued, we may not be able to provide replacement products even within the warranty period.  

For repairable products, we will, in principle, undertake repairs for five (5) years after the discontinuance of those products. In 
some cases, however, we cannot undertake such repairs for reasons, such as the absence of repair parts.  For system products, field 
instruments,  we may not be able to undertake parts replacement for similar reasons. 

9. Scope of services 

Prices of Azbil Corporation’s products do not include any charges for services such as engineer dispatch service. Accordingly, a separate 
fee will be charged in any  of the following cases: 

(1) Installation, adjustment, guidance, and attendance at a test run 
(2) Maintenance, inspection, adjustment, and repair
(3) Technical guidance and technical education 
(4) Special test or special inspection of a product under the conditions specified by you

Please note that we cannot provide any services as set forth above in a nuclear energy controlled area (radiation controlled area) or at a 
place where the level of exposure to radiation is equivalent to that in a nuclear energy controlled area. 

 AAS-511A-014-10
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Specifications are subject to change without notice. (10)

1st edition: Apr. 2015 (V)
3rd edition: Feb. 2019 (V)
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